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CHAPTER 24

Soil erosion modelling

By:
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International Institute for Aerospace Survey and Earth Sciences (ITC),
P.O. Box 6, 7500 AA Enschede, The Netherlands.
Tel: +31 53 4874264, Fax: +31 53 4874379, e-mail: SHRESTHA@ITC.NL

Summary
Soil erosion modelling, described here, is based on the methods explained by
Morgan (1986); Morgan, Morgan and Finney (1984). The model tries to encompass
some of the recent advances in understanding of erosion processes. The model
separates the soil erosion process into a water phase and a sediment phase. It
considers soil erosion to result from the detachment of soil particles by raindrop
impact and the transport of those particles by overland flow.

Getting started
The data for this case study are stored on the ILWIS 3.0 CD-ROM in the directory
D:\Data\ILWIS 2.1 Applications Guide Data\chap24 (where D is the drive letter
of the CD-ROM drive). If you have already installed the data on your hard disk, you
should start up ILWIS and change to the subdirectory where the data files for this
chapter are stored. If you did not copy the data for this case study from the CD-
ROM to your system yet, please do this before continuing. It is also possible to
download the data from the ILWIS Internet site at http://www.itc.nl/ilwis/.

F 
• Double-click the ILWIS icon on the desktop.

• Use the Navigator to go to the directory where the data files for this
chapter are stored.

Now you are ready to start the exercises of this case study.
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The study area
The sub watershed of Sitla Rao is selected to run the erosion model. It is located in
the western part of Doon valley, Dehradun District, Utter Pradesh in India. The sub
watershed belongs to the Asan river system which is a tributary of Yamuna river.
The area lies approximately between 77°45'33" and 77°57'46" East longitudes and
30°24'39" and 30°29'05" North latitudes, covering approximately 55 km2. The
altitude varies from 440 to 2300 m asl. The climate is characterized by hot summers
and cold winters. The rainfall varies from 1600 to 2200 mm, depending on
elevations, most of which falls in the rainy season (June-August). The area is
characterized by having an East-West oriented mountain range belonging to the
Middle Mountains of the Indian Himalayas, a chain of erosional hills, extensive
piedmont and river valleys. Land cover/land use is characterized by forest, grazing
land and agriculture. In the lower elevation forest type is dominated by sal trees
(Shorea robusta) while in the higher elevations the forest is of mixed type. Main
crops are rice, wheat, maize and sugarcane.

24.1 Map digitizing
The material used in this section comprises two maps. Map1 contains villages and
roads and Map2 (optional exercise) contains contour information. In ILWIS, these
data are entered and stored as separate digital files; as point file (for village
locations) and as segment files (for roads, contour lines).

Both maps are available in Adobe Acrobat PDF format (Map1&2.pdf) and need to
be printed in landscape format on A4 paper before digitizing.

F 
• Create a coordinate system file by selecting Create, Coordinate

System from the File menu of the Main window. The Create
Coordinate System dialog box will open.

• Enter Coordinate System Name Sitlarao and select the option
“CoordSystem Projection’’.

• Enter the minimum and the maximum values for the X and the Y
coordinates as follows:

Minimum X = 764090
Maximum X = 784720
Minimum Y = 3364830
Maximum Y = 3376870

• Select the other parameters: for Projection select UTM, for Ellipsoid
select Everest (India 1956) and for Datum select Indian
(India, Nepal). Make sure the Northern Hemisphere check
box is selected and type 44 for UTM zone.

• Similarly, create a georeference file Sitlarao. The georeference
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Type should be GeoRef Corners and the Coordinate System
should be the one you have just created. For the Pixel size type 30
m. The X and the Y coordinates will be copied from the coordinate
system file.

24.1.1 Creating a point map
In this exercise, you will create a point map showing the locations of villages. It is
also possible to create a coordinate system and a domain or to select objects that
already exist.

F 
• Select Create, Point Map from the File menu of the Main window.

• In the Create Point Map dialog box, type Villages in the Map
Name text box and select the Coordinate System file you have
created in the previous exercise.

• Click the Create Domain button next to the drop-down list box.
Type Villages in the Domain Name text box, accept Class for
the domain type and click OK. The Domain Class editor appears.

• Close the domain editor and click the OK button in the Create Point
Map dialog box.

The Point editor is opened and the village locations can be digitized but in order to
do so the printed map has first to be fixed on the digitizing table and the map should
be referenced so that the system knows where you have put the map on the
digitizing table.

F 
• Exit the Point editor for the moment.

• Place Map1 (the map with the village locations) on the digitizer and
reference it if you have not done so. (Note: the digitizer should have
been set up correctly beforehand).

• Village locations can now be digitized. Open and edit the point map
you have created and digitize the villages. Also enter the village
names.

• Exit the Point editor when all the villages are digitized and save your
work.

24.1.2 Creating a segment map
In this exercise you will create a segment map comprising the lines of the road
network in the area. Although not always necessary, we will assume that a network
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analysis will be carried out later. The individual segments will therefore be
connected to each other.

F 
• Select Create, Segment Map from the File menu of the Main

window.

• Type a name (Road) for the segment map. Select the coordinate
system you have created.

• Click the Create Domain icon next to the drop-down list box. Type
Road in the text box Domain Name, accept Class as the domain
type and click OK. The Domain Class editor is opened.

• Close the domain editor and click OK in the Create Segment Map
dialog box.

! Why is the domain type class selected and not, for example, the domain type
identifier or value?

The Segment editor and Add Segments command box are now opened. The
Segment editor works in Select Mode, Move Points Mode, Insert Mode and
Split/Merge Mode. To start digitizing the main roads, a new class must be added to
the domain which can be done as follows:

F 
• In the Segment editor, open the Edit menu and click Insert Code.

• Select Class Name <new> from the list in the Edit box.

• In the Add item to Domain dialog box, type Main road in the text
box Name, type a short code, for example MR, in the text box Code,
select a suitable Color (Red) and click OK.

• Click the OK button in the Edit dialog box.

You are now ready to start digitizing the individual line segments.

24.1.3 Changing the properties of maps
For this case study a number of digital maps are already provided such as the
segment maps of contour and drainage lines and the polygon maps of soil and
landuse information. Please note that the coordinate system of the supplied maps is
Unknown. In this exercise, you will change the properties of the maps and connect
them to the coordinate system you have created.
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F 
• In the Catalog, click segment map Contour with the right mouse

button and select Properties from the context-sensitive menu. The
Properties sheet will be displayed.

• Change the coordinate system from Unknown to the coordinate
system you have created. Accept all other defaults and click OK.

• Similarly, change the coordinate system of other maps (Drainage,
Soil and Landuse) from coordinate system Unknown to the
coordinate system Sitlarao.

24.2 Rasterization
Raster maps can be generated from vector data (point, segment or polygon maps).
For the output raster map, an existing georeference has to be selected or a new one
can be created. The georeference determines the pixel size and the number of lines
and columns of the output map. It uses a coordinate system. A georeference file
stores the relation between lines and columns of a raster map (row, col) and
coordinates (X, Y).

F 
• In the Operation-tree, expand Rasterize and double-click the

Polygon to Raster operation. The Rasterize Polygon Map dialog
box will be opened.

• Enter the input Polygon Map (for example Soil), the Output
Raster Map name and the GeoReference file you have created.

• You can display the rasterized map if you like by clicking the Show
button (optional) or just define the dependent output map by clicking
the Define button.

Check the properties of the rasterized map and verify that the pixel size is 30 m.

24.3 Attribute data and map generation
Upon completion of this exercise you should be able to generate attribute maps from
attribute tables, carry out table calculations and generate maps.

24.3.1 Working with an attribute table
In order to generate attribute maps a table should be available which is linked to the
map. An attribute table can be created and edited by making use of column
operations.

A soil attribute table is provided to you in which new data have to be entered. Once
the attribute data are entered, table calculations can be performed.
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Table 24.1: Soil attribute table, Sitla Rao Watershed, Doon valley, Dehradun, India

Soil map
unit

Number of
polygons

Area (m2) Drainage class Surface texture Soil depth class

H11 10 2449561 Well drain Gravely loam Shallow

H12 3 2829484 Well drain Loam Deep

H13 1 246370.4 Well drain Gravely loam Deep

H21 6 2977356 Well drain Loam Deep

M1 5 1070312 Exc. drain Gravely sandy
loam

Shallow

M2 1 5713150 Exc. drain Gravely sandy
loam

Shallow

M3 3 535729.9 Exc. drain Gravely sandy
loam

Shallow

P11 4 2198135 Well drain Gravely loam Deep

P12 6 6610258 Well drain Loam V. deep

P21 6 4503889 Well drain Gravely sandy
loam

V. deep

P22 6 5277803 Well drain Sandy loam Deep

river 1 6125919 ? ? ?

V1 2 9911202 Well drain Loam Deep

V2 9 4213459 Exc. drain Loamy sand Deep

V3 4 652134 Well drain Sandy loam Deep

Table 24.1: Soil attribute table, Sitla Rao Watershed, Doon valley, Dehradun, India (cont.)

Soil map
unit

pH
(top soil)

Stoniness % Bulk density
(g/cm3)

Moisture storage
capacity

k fact

H11 6.6 40 1.3 0.18 0.45

H12 6.5 20 1.3 0.18 0.50

H13 7.2 50 1.4 0.20 0.40

H21 6.8 20 1.3 0.20 0.48

M1 7.5 90 1.2 0.26 0.45

M2 7.0 90 1.2 0.25 0.43

M3 6.8 90 1.2 0.25 0.40

P11 6.8 35 1.4 0.18 0.35

P12 6.6 15 1.3 0.20 0.40

P21 7.2 10 1.3 0.20 0.36

P22 7.4 5 1.2 0.28 0.38

river ? ? ? ? ?

V1 6.8 0 1.3 0.20 0.41

V2 7.0 5 1.4 0.10 0.30

V3 6.8 40 1.2 0.15 0.35
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Table 24.2: Land use attribute table, Sitla Rao Watershed, Doon valley, Dehradun, India

Land use Nr. of
polygons

Area (m2) C A Et/E0 RD

Barren land 1 786600 1.000 0 0.05 0.01

Degraded sal forest 1 492300 0.030 20 0.80 0.10

Dense mixed forest 6 1053900 0.010 20 0.90 0.10

Dense sal forest 9 9887400 0.004 20 0.90 0.10

High intensity cultivation 2 12099600 0.300 43 0.85 0.07

Low intensity cultivation 8 9184500 0.500 30 0.60 0.05

Open mixed forest 1 6710400 0.050 15 0.80 0.10

Open sal forest 8 8530200 0.006 15 0.80 0.10

Orchard 2 53100 0.007 20 0.90 0.10

River 1 6012000 0.000 ? ? ?

F 
• Display the Soil table by double-clicking it in the Catalog. The

Soil table will be opened. You will notice that the first column
shows the soil map units and the second column shows the area in
m2. Some other soil attributes are also given.

• To add the attribute pH of surface soil, select the Add Column
option from the Columns menu in the table window.

• Enter the Column Name pH and accept the default Value
Domain. Define the Value Range (which will be from 1 to 14 for
pH), enter 0.1 for the Precision and click OK.  The column pH
will appear in the table.

• Enter the pH values per soil mapping unit (use Table 24.1).

• Update the Soil table by creating columns and entering the values
for stoniness, bulk density of topsoil (BD), moisture storage capacity
(MS), soil detachability index (K), etc. Close the table window once
the table is updated.

24.3.2 Linking an attribute table to a map and generating attribute
           maps

Once you have created and entered all the attributes in the table, the table can be
linked to a (raster) map and attribute maps can then be created.

F 
• In the Catalog, click raster map Soil with the right mouse button

and select Properties from the context-sensitive menu. The
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Properties sheet will be displayed.

• In the Properties sheet, select the check box Attribute Table and
choose the Soil table from the drop-down list box. If the map is
Read Only, first select the General tab and deselect the Read Only
check box.

The Soil table is now linked to the Soil map. Suppose you want to create a map
which shows only the pH of the top soil. This attribute map can be easily created by
following the steps as shown below:

F 
• In the Catalog double-click raster map Soil. The Display Options

– Raster Map dialog box will be opened.

• Click the Attribute check box and select attribute column pH.
Accept all other defaults and click OK.

The map showing the pH of the top soil is displayed. Check with the left mouse
button if the map units have different pH values. The above example shows you how
to display an attribute map but an attribute map showing only pH values can also be
created as follows:

F 
• Type the following formula on the Command line of Main window:

 pH = Soil.Ph ↵

• The Raster Map Definition dialog box is opened. Press Show. The
dependent raster map pH is created and the Display Options dialog
box is opened.

• Click OK to display the newly created pH map.

The example above has shown you how to edit and update a Soil table, how to link
it to the raster map Soil and how to generate attribute maps. Similarly, update the
Landuse table.

F 
• Create and enter the values for crop cover management factor (C),

percentage rainfall contributing to interception (A), ratio of actual to
potential evapotranspiration (Et_E0), and rooting depth (RD).

• Close the table and link it to raster map Landuse.
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24.4 Generation of a DTM and its applications
Upon completion of this exercise you should be able to generate a Digital Terrain
Model (DTM), a slope map and various applications related to DTMs, based on the
digitized contour lines. It is also possible to generate slope exposition from a Digital
Terrain Model.

Terrain slope plays quite an important role not only on its influence in soil formation
and development but also on degradation of land, caused by soil erosion. Having
other erosion parameters being constant, we can assume that the higher the slope
gradient the larger the risk of soil erosion. Thus it is very important to compute slope
gradient. Terrain slope gradient is one of the most important parameters in soil
erosion modelling in GIS. It is also essential in many land use planning exercises.

24.4.1 Digitizing the contour map
For details about digitizing refer to the digitizing exercise for this case study
(segment digitizing, with domain type value). For this exercise, however, a segment
file called Contour is available.

24.4.2 Interpolating the contours
Once you have digitized contour lines, stored as a segment file, the next step is to
interpolate the segments by which a raster map (digital elevation map) is created
with a certain pixel size. The size of the pixels is already defined by the
georeference you have created.

F 
• Select Interpolation, Contour Interpolation from the Operations

menu in the Main window. The Contour Interpolation dialog box is
opened.

• Select segment map Contour as input map, type an Output Raster
Map name (Elevation) and select the GeoReference you have
created. Keep the Domain type as Value.

• The Value Range and the Precision required can be defined,
depending on your data.

Display the output map and check the pixel values, which indicate the terrain
heights. Break the dependency of the map if the interpolation result is satisfactory.

24.4.3 Computation of height difference maps
Once you have a digital elevation map you can compute slope gradients. For this
purpose height differences need to be computed in X and Y directions since overall
slope gradient is a function of height differences over horizontal distances in both X
and Y directions.
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F 
• Open the Filtering dialog box by double-clicking the Filter operation

in the Operation-list.

• Select input Raster Map Elevation and select the Linear filter
dfdx.

• Give a name (Dx) for the Output Raster Map, accept all other
defaults and click Show.

The filtering operation with the filter dfdx will compute height differences in west-
east direction where the positive value in the resulting map indicates the increase of
height, the negative value indicates the decrease of height and a zero indicates no
difference. Perform filtering in north-south direction and store the result in a map
called Dy.

24.4.4 Generation of a slope map
Slope can be generated either in percentage values or in degrees or radians. In some
erosion models slope percentage values are required as input data (Universal Soil
Loss Equation) while some models demand slope degrees as input values.

F 
• On the Command line of the ILWIS Main window, enter the

following formula:

 Slope_p = 100*HYP(Dx,Dy)/30 ↵

 This formula will generate a slope map in percentages. Note that the
value 30 in the formula refers to the pixel size.

• To compute the slope in degrees, enter the following formula:

Slope_d = RADDEG(ATAN(Slope_p/100)) ↵

You have noticed that slope in degrees is simply a conversion of slope percentage
values into degrees. In this case you have to compute first the slope in percentages.
Also, the value in radians needs to be converted into degrees by using the function
RADDEG. Notice that the trigonometric function ATAN returns real values in
radians.

! Can you think of an equation by which you can compute the slope in degrees
directly from the Dx and Dy maps? Write down the formula and convert it into
an ILWIS map calculation command and generate the slope map in degrees.
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If you display the map you will notice that the whole screen is covered by slope
values whereas the watershed boundary is smaller.

F 
• Use MapCalc to mask the areas belonging to the watershed and store

the final slope map in a map called Slope. (Hint: use the map Soil
to mask the watershed area).

24.4.5 Generation of a rainfall map based on a DTM
In an area with known variations of annual rainfall, caused by elevation differences
a DTM can be used to generate a rainfall map. Assuming that no rain shadow area
exists in the watershed, a regression analysis of annual rainfalls with different
elevations can be performed and if the correlation coefficient is found to be high
enough an equation can be derived to compute a rainfall map from elevation data.

In the Sitla Rao watershed good correlation was found between annual rainfall and
elevation differences (r value of 0.743). Thus an equation can be derived to compute
a rainfall map as follows:

Elevation329.02.1384Rainmap ⋅+= [24.1]

F 
• Translate equation 24.1 into a map calculation formula and generate

the map Rainmap.

• Mask the Rainmap so that only the watershed area is displayed. Call
the output map Rain.

24.4.6 Classification of the rainfall map
If you display the Rain map you will notice that every pixel will have a certain
value indicating the amount of rainfall. It will be ideal to classify or group the
rainfall amounts into certain classes. This can be done by creating a class domain.

F 
• Select Create, Create Domain from the File menu in the Main

window. The Create Domain dialog box is opened.

• Enter a Domain Name (Rain). Accept the domain Type Class,
select the Group check box and click OK. The Domain Group
editor is opened.

• Select Edit, Add Item. Enter Upper Bound 1600 for the rainfall
value, enter 1600 mm as Name and click OK.
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• Add items for the rainfall values 1700, 1800, 1900, 2000, 2100
and 2200 as explained above. Close the Domain Group editor
when all the values are added with proper class names.

The domain group is created. Now you can classify the map Rain into a rainfall
class map.

F 
• Classify the Rain map and generate a rainfall class map using the

Command line of the Main window:

 Rainclas = CLFY(Rain,Rain) ↵

If you display the map Rainclas you will notice that it is a class map and not a
value map. To be able to use the rainfall data in erosion modelling a value map is
required. For this purpose an attribute table needs to be created for the map
Rainclas. In the attribute table a column needs to be created with rainfall values.
It can be created as follows:

F 
• In the Main window open the File menu and select Create, Table.

• Enter a name for the table (Rainclas), select the Domain Rain
and click OK. The table will be opened.

• Add a column called Rainfall, with Domain Value with Value
Range 0 – 2500 and Precision 1.

• Enter the corresponding values of rainfall for different rainfall
classes.

• Create a rainfall value map by entering the following command:

Rainfall = Rainclas.Rainclas.Rainfall ↵

where Rainfall is the output map, Rainclas is the input map,
the second Rainclas is the input table and the second Rainfall
is the column in the table Rainclas.

Based on the climatic data it seems that the number of average rainy days in a year
appears to be 75 days in the lower elevations while the average rainy days are 95 in
Mussoorie.

F 
• Generate a map Rn which shows annual rainy days as a function of
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elevation as follows:

Elevation                             Number of rainy days
up to 700 m 75
from 701-1200 m 85
more than 1200 m 95

24.5 Generation of rainfall energy and the rate of soil
detachment by raindrop impact

Upon completion of this exercise you should be able to generate a map indicating
the rate of soil detachment by raindrop impact. You should also be able to compute
kinetic energy of rainfall, which is dependent on the annual amount of rain and the
rainfall intensity.

24.5.1 Generation of a rainfall energy map
Kinetic energy of rainfall (E) in J/m2 is dependent on the amount of annual rain (R)
and the rainfall intensity (I). It can be derived by the following equation, established
by Wischmeier and Smith (1978):

)Ilog7.89.11(RE 10 ⋅⋅+⋅= [24.2]

For computing the rainfall energy, the Rainfall map generated earlier in the
exercise can be used. For rainfall intensity take the value of 25 mm/hr for Sitla Rao
watershed and generate the rainfall energy map.

24.5.2 Estimation of the rate of soil detachment
Soil detachment is a function of soil detachability index defined as the weight of soil
detached from the soil mass per unit of rainfall energy.

It can be computed by using the following equation:

3)A05.0( 100.1)expE(KF −⋅− ⋅⋅⋅⋅= [24.3]

where F is the rate of soil detachment in kg/m2, K is the soil detachment index and A
is the percentage rainfall contributing to permanent interception.

F 
• Generate attribute maps of soil detachability index K (hint: use the

Soil table) and percentage rainfall contributing to permanent
interception A (hint: use the Landuse table).

• Translate equation 24.3 into an ILWIS MapCalc command and
generate the soil detachment rate map F.

• Display the map, there should be no unknown pixels in the map
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anymore.

24.6 Generation of overland flow map
The objective of this exercise is to generate a map indicating the volume of overland
flow. Overland flow (Q) is dependent on moisture storage capacity (MS) of surface
soil which can be derived from field capacity. It is also dependent on the soil bulk
density (BD). Moreover it is dependent on rooting depth (RD) of various cover
types, the ratio of actual to potential evapotranspiration (Et/E0), the amount of annual
rain (R) and the number of rainy days (Rn). It can be explained by the following
equations:

)R/R( 0cexpRQ −⋅= [24.4]

where:

0.5
0tc )/E(ERDBDMS1000R ⋅⋅⋅⋅= [24.5]

n0 RRR /= [24.6]

24.6.1 Calculation using MapCalc

F 
• As shown by the equations above 6 maps are required. From the

attribute tables linked to the corresponding maps (Soil, Landuse,
Rainfall and the map showing the number of rainy days Rn)
generate the required attribute maps.

• Compute formulas 24.5 and 24.6 in MapCalc. Call the output maps
Rc and R0.

• Compute the volume of overland flow Q by translating equation
[24.4] into an ILWIS formula and store the result in a map Q. If
necessary, break the dependency of the file.

24.6.2 Calculation by means of map crossing
The computation of overland flow (above) makes use of map calculations. Another
option is by crossing the maps Soil and Landuse by which a cross table and a
cross map can be generated. In this way it is not necessary to generate all the
attribute maps. Most of the calculations can be performed in the table itself.

F 
• In the Operation-tree, expand Raster Operations and double-click

the Cross operation. In the Cross dialog box enter the 1st Map
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Soil and 2nd Map Landuse to cross. Enter a name for the Output
Table (Soilland), give the Output Map the same name and show
the result.

In the cross table the necessary attributes from the Soil and the Landuse tables
should be joined so that table calculations can be performed.

F 
• In the cross table Soilland open the Columns menu and select

the Join command. The Join Wizard is opened.

• Select table Soil and column MS and accept the default values for
key column and output column name.

The column MS will be added to the cross table Soilland.

F 
• Join other relevant columns (BD, RD, Et_E0) from the tables Soil

and Landuse.

• Compute the product of MS, BD, RD and the square root of Et_E0,
and multiply by 1000. Store the result in a column RC.

• Generate an attribute map RC2 based on the column RC in the cross
table.

• Compute the volume of overland flow and store the result in a map
Q2.

! - Which map unit of land use has the highest possible volume of overland flow?
- Which soil unit has the lowest volume of overland flow? Explain the reason.

24.7 Generation of transport capacity of overland flow
The objective of this exercise is to generate a map indicating the transport capacity
of overland flow.

24.7.1 Estimating the transport capacity
Transport capacity of overland flow (G) is dependent on the volume of overland
flow (Q), the crop cover management factor (C) and the topographic slope factor
(S). It can be calculated by using the following equation:

30.2 10SsinQCG −⋅⋅⋅= [24.7]
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F 
• Generate map C (the crop cover management factor map) from the

attribute table Landuse.

• Write down on a piece of paper equation 24.7 into an ILWIS
formula.

Note: Please keep in mind that in ILWIS the trigonometric function SIN assumes
the value in radians instead of degrees. The slope value S should thus be
converted into radians by adding an ILWIS command DEGRAD.

The MapCalc formula to compute transport capacity of overland flow (G) can be
rewritten as follows:

1000/))S(DEGRAD(SIN*)Q(SQ*CG = [24.8]

Note: The unit of the result is in kg/m2.

F 
• Calculate map G.

24.8Estimation of soil erosion
Soil loss estimation is calculated from the transport capacity of overland flow (G)
and the estimated rate of soil detachment (F). If the transport capacity is higher than
the rate of soil detachment, the soil detachment value will be taken as the soil loss.
Similarly, if the rate of soil detachment is higher than the transport capacity of
overland flow, the value of the transport capacity will be considered as the soil loss.

24.8.1 Soil loss estimation
Since the lower value of the transport capacity of overland flow and the estimated
rate of soil detachment is taken, use the minimum function MIN in ILWIS.

F 
• Compute the soil loss. The formula will be as follows:

 Soilloss = MIN(G,F) ↵

• Display the map Soilloss and check the results.

• As the unit of the values shown in the result is kg/m2, convert the data
to make it into ton/ha. Store the soil loss map in ton/ha in a file
Erosion with domain Type Value and with a Precision of 1.
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24.8.2 Soil loss estimation per land use class
It will be interesting to see the soil erosion per land use class. For this purpose it is
necessary to cross the maps Landuse and Erosion and aggregate the soil loss
values per land use classes.

F 
• Cross the maps Landuse and Erosion and enter a name for the

cross table. It is not necessary to create a cross map.

• Display the cross table you have created. Once the cross table is
opened, soil loss aggregation can be performed per mapping unit.

• In the cross table, open the Columns menu and select Aggregation.
The Aggregate Column dialog box is opened.

• Select the Column Erosion and the Function Average. Select
the check box Group by and the column Landuse.

• Select the Output Table check box and type Landuse as output
table name.

• Enter an Output Column name (Avg_soilloss) and click OK.

• Compute the standard deviation of the soil loss per land use class
and add column Std_soilloss to table Landuse.

! - Which land use type has the highest estimation of soil loss?
- Which land use type has the lowest estimation of soil loss?
- What do you think is the main reason for having a higher soil loss estimation
 in low intensity agriculture as compared to high intensity agriculture?
- If a soil loss of 20 ton/ha is taken as the tolerable amount of soil loss

considering the fact that many areas lie in the hilly to mountainous
terrain,which land use/land cover types are still at higher risk?

24.8.3 Soil loss estimation per soil map unit
The same procedure can be applied to the Soil map to calculate the soil loss
estimation per soil map unit.

F 
• Update the table Soil by computing and adding the columns

average soil loss and the corresponding standard deviations.
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! - Which soil map unit has the lowest and which soil unit has the highest soil
  loss estimation?
- Which units have a soil loss estimation of more than 20 ton/ha?
- What is the main reason for having higher soil losses?

24.9 Display of maps and adding annotations
Upon completion of this exercise you should be able to display vector data such as
drainage lines, rivers, roads, villages, etc. on a raster or a polygon map, and create a
layout.

F 
• Display the raster map Erosion. To get a better result when

printing, convert the raster map into a polygon map with the Raster
to Polygon operation (Tip: for an even better result classify the
erosion map by converting the value domain into a class domain
before making polygons. Classes can be 0 – 10 ton/ha, 11 – 20
ton/ha, 21 – 30 ton/ha, etc.).

• Add polygon map River (which can be masked from the Soil or
Landuse polygon map).

• Add also the drainage lines (segment map Drainage), the road
infrastructure (segment map Road) and the village locations
including the village names (point map Villages and annotation
text layer Villages). Grid Lines or Graticules can be also added.

Now all the layers are displayed in the map window. Furthermore, all layers appear
in the Layer Management pane (left hand side of the map window). To save the
map view:

F 
• Open the File menu in the map window and select Save View As.

Finally, a layout can be created. A layout is a virtual sheet of paper on which you
can insert annotation objects. Annotation objects such as a legend, a scale bar, a
north arrow, etc. make the map easier to read.

F 
• In the map view open the File menu and select the Create Layout

command. The Set Scale dialog box appears.

• In the Set Scale dialog box change the scale to 1:120000 and click
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OK. The Layout editor will be opened.

In this stage of creating a layout, you can change the page setup and choose the
paper size, orientation (portrait or landscape) and margins. The page setup can still
be changed later if needed, but you may have to rearrange all items in the layout if
you change the size or orientation of the paper.

F 
• From the File menu of the Layout editor, select Page Setup. The

Page Setup dialog box is opened.

• Make sure the Paper Size is A4, change the Orientation to
Landscape and click OK. The orientation of the layout is now
changed into landscape.

• Add a Scale Bar, a North Arrow, a Map Border, a map title and
other necessary information. It is also possible to add the map
coordinates along the map borderline, to add other map views on
different scales or to add pictures/bitmaps.

• The map layout can be saved and the map can be printed, when
everything is finalized and you are satisfied with the result.
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